# Table of Contents

## INSTALLING ROLL CALL for CHILD CHECK-IN
- Hardware/Software Requirements .............................................................. 4
- Roll Call Software Installation ................................................................. 4
- Check in Station Hardware Installation .................................................... 5

## CONFIGURING CHECK-IN
- Using the Setup Assistant ....................................................................... 7
- Using the Setup Menu ............................................................................. 9
- User Security and Check In Users .......................................................... 10
- Name Tags & Parent Tags ....................................................................... 16
- Check In Preferences ............................................................................ 18
- Groups ................................................................................................. 19
- People ................................................................................................. 20
- Key tags .............................................................................................. 21

## CUSTOMIZING CHECK-IN LABELS
- Set the Label Size .................................................................................. 22
- Customize the Parent Tag ....................................................................... 22
- Test the Parent Tag ............................................................................... 26
- Customize the Child Name Tag .............................................................. 26
- Test the Child Tag ................................................................................. 29
- Customize the Adult/Youth Name Tag.................................................... 30
- Test the Adult/Youth Tag ..................................................................... 33
- Customize Visitor Check In Screen ...................................................... 33

## MANAGING GROUPS FOR CHECKIN
- Add a Group through the Setup Assistant ............................................. 38
- Add a Group through the Navigator Menu ........................................... 38
- Graduation ............................................................................................ 42

## ADDING PEOPLE FOR CHECK IN
- Import contact information ................................................................... 45
- Use Add a Family Screen ...................................................................... 47
- Update Check In Settings ....................................................................... 49

## OPERATING THE CHECK IN STATIONS (Computer Stations)
- Log into the Check In Station ............................................................... 50
- Check In Using a Last Name .................................................................. 50
- Check In Using a Phone Number ......................................................... 52
- Check In Using a Touch Screen ........................................................... 56
- Check in Options .................................................................................. 57
- Add a New Person into an Existing Family .......................................... 60
- Check in Visitors ................................................................................ 61
- Check In by Individual Using a Last Name or Phone ......................... 63
- Check in by Individual Using a Bar Code ........................................... 65
- Check into Service ............................................................................... 66
- Determine Headcounts ........................................................................ 66
- Check Out ............................................................................................. 66
- Sending Texts from Check In Screen ................................................... 70

## OPERATING THE CHECK IN STATIONS (Tablets)
- Log into the Check In Station ............................................................... 74
- Customizing the Appearance ............................................................... 74
Check In Using a Last Name or Phone Number .................................................................75
Check in Options ..................................................................................................................77
Add a New Person into an Existing Family ...........................................................................81
Check In by Individual Using Last Name or Phone ..............................................................81
Check in Visitors ...................................................................................................................84
Check In by Service ...............................................................................................................85
Check In by Keyword ..........................................................................................................87
Determine Headcounts ........................................................................................................87
Check Out ............................................................................................................................88
Sending Texts from Check In Screen ..................................................................................90

OPERATING THE CHECK IN STATIONS (Smart Phone)
  Log into the Check In System .............................................................................................92
  Check In Using a Last Name or Phone Number ................................................................92
  Check in Options ................................................................................................................94
  Add a New Person into an Existing Family .......................................................................96
  Check in Visitors ...............................................................................................................97
  Check In by Group .............................................................................................................98
  Check In by Service ..........................................................................................................99
  Check In by Keyword .......................................................................................................100
  Determine Headcounts ....................................................................................................100
  Check Out ........................................................................................................................101

USING FINGERVEIN SCAN TO CHECKIN
  Fingervein Technology Configuration ..........................................................................105
  Fingervein Set Up with Roll Call .....................................................................................105
  Connect a Fingervein with a Person in Roll Call ..............................................................106

REPORTING ON ATTENDANCE
  Attendance Summary .......................................................................................................109
  Attendance by Person ......................................................................................................111
  Attendance by Type .........................................................................................................114
  Attendance by Session .....................................................................................................115
  Absent Present Report ......................................................................................................117
  Visitor Report ....................................................................................................................119
INSTALLING ROLL CALL for CHILD CHECK-IN

Hardware/Software Requirements

Roll Call workstations
If you will only be using one check-in station, you’ll want to install Roll Call Standalone. If you will be using multiple check in station, each “kiosk” needs to have a computer with Roll Call Client. That computer must have a network connection so that it can connect to Roll Call Server.

Bar Code scanner
If you will be checking students in using bar code technology, each check-in station will need a bar code scanner. The scanner needs to be a keyboard wedge device with the ability to scan a single digit. We recommend the Voyager CG hand held scanner. These scanners may be purchased through By the Book.

Dymo LabelWriter
This printer is required if you wish to print labels for the child and parent upon check in. The program is expecting a Dymo LabelWriter 450 or 450 Turbo printer. You may choose from 2 different label sizes, the 30256 shipping label or the 30334 multi-purpose labels.

Brother Wireless Label Printer (QL-710w)
This printer is an option if you will be using Mobile CheckIn and would like to print the nametags and parent tags to a wireless printer. The brother label stock that we support is the 66 mm x 100 mm size.

Finger Vein Scanner
If you will be checking students in using biometrics, you’ll need the M2Sys finger print scanner connected to a Windows version of Roll Call.

Finger Vein Software
If you’ll be checking students in using their fingerprint, you’ll need the M2Sys finger vein software installed on a Windows computer.

Roll Call Software Installation

Single user version
The single user version of Roll Call allows one user, on one computer to access Roll Call. For the single user installation, use the following instructions.

To install Roll Call double click on the Roll Call installer file you downloaded. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, you will have a Roll Call icon on your desktop. If you are a Mac user, you will need to drag the application to your dock. To use Roll Call, double click on that icon.

Network Version
A network installation of Roll Call allows multiple people to access the data. If you have a multi-user license, multiple users can access the data simultaneously. For example, if you want to have 3 check in stations, you will need to use the network version of Roll Call so all 3 stations are
looking at the same information.

For the network installation, you will need to have your computers networked together. You will need to install Roll Call Server software on the computer that will house the database. You will need to install Roll Call Client software on all computers that need access to the data.

To install Roll Call Server double click on the Roll Call Server installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Server icon on the desktop. To start Roll Call Server, double click on the icon. For users to work in Roll Call the Server must be running.

To install Roll Call Client double click on the Roll Call Client installation file. The install program will prompt you through the process. Click on the NEXT button to continue through each step of the process.

Once the installation is complete, there will be a Roll Call Client icon on the desktop. To start Roll Call, double click on the icon. The Client will see Roll Call Server running on the network and connect to it.

**Check in Station Hardware Installation**

In a network environment, each check in kiosk should have Roll Call Client installed with access to Roll Call Server. In a single kiosk environment, the station should have Roll Call standalone installed.

**Bar Code Scanner**

If will be using bar code technology to check student’s in, plug the scanner into a USB port on your check in station. You can confirm that the scanner is working properly by scanning a bar code from a badge or key tag while you are in Text Edit (Mac) or Notepad (Windows) If this number pops into the page, the scanner is working properly.

**Dymo Labelwriter**

If will be printing labels as name tags and/or security labels, plug your Labelwriter into a USB port. Make sure to install the printer drivers.

If you are on a Windows machine, go to Printers and Faxes at the operating system level and choose properties for the Dymo Labelwriter. Click on Printing Preferences. For the 30334 labels, click Portrait. For the 30256 labels, select Landscape.

If you are a portable church, or are plugging the Labelwriters in each Sunday, please note, on some Windows machines, a new printer definition is created each time you plug in the printer. Make sure you only have ONE Labelwriter printer definition and that it is online.

**Brother Wireless Label Printer (QL-710w)**

If will be using Mobile CheckIn (iPads, Tablets or Smartphones) for check in, you may choose to print your labels on a Brother wireless printer. You will need to install the print drivers for each Brother printer on a computer that will be logged into Roll Call during your check in timeframe. You can define multiple brother printers on a single computer, but make sure to give them unique names.
**Finger Vein Scanner**

If you will be using the finger print scanner, plug the scanner into a USB port on your Windows check in station. Make sure that the biometric client software is installed on your check in station. See installation instruction for the biometric client and server from M2SYS.
CONFIGURING CHECK-IN

There are several ways to configure the check in system. You can use the set up assistant that is presented when you start Roll Call for the first time. This set up assistant will walk you through setting up the basic information required to use check in. The other option is to use the Setup menu under the CheckIn/Out menu in Roll Call. This set up wizard is a more complete method and will give you more options.

Using the Setup Assistant

When you start Roll Call for the first time, you will be asked a series of questions about how you will use Roll Call. This series of questions is called the Setup Assistant. You can also get to the setup assistant from the Administration top menu. For the purposes of this manual, we’ll start with the questions regarding Check In. If you answer Yes that you will be using Check In, you will be taken through this series of steps.

Security

To use Roll Call’s check in system, you must “sign into” the system as a check in user. You should have been asked to give Administrator a password as part of the Setup Assistant. This is what activates the security system. If you did not complete this step, click on the PREV button to do that.

Give the Administrator user a password then click NEXT.

Check In Users

To add a check in user, enter the following information:
1. *Username* – enter the name for this specific check in user.
2. *Password* – enter a password for this specific user or leave it blank.
3. *Confirm* – re-enter the password if you entered one.

Enter the name of your check in user and assign a password.
To move on to the next step in the set up assistant, click NEXT.

**Check In Background**

Mark the image you’d like for the background of the check in screen. You may choose one of these images or click custom to pull in your own graphic.

Choose your background image.

**Check In Groups**

Check In Groups are the events, classes or meetings that you will be checking people into. To define a group, enter the following information:

1. **Name** – the name of the group you are setting up.
2. **Day** – the day of the week that the class, meeting or event happens.
3. **Start Time** – the time that the class, meeting or event begins.
4. **End Time** – the time that the class, meeting or event ends.
5. **Grade or Age** – is this class, meeting or event limited to people in a certain grade or age range. If so, choose Grade or Age.
6. **Grade range** – if the class is for students in a certain grade, enter the “from” and “to” grade.
7. **Age range** – if the class is for students of a certain age range, enter the “from” and “to” age.

Enter the group name, time they meet and grade range.

Make sure to hit the plus sign to save the class and add another.
Check In Printing

The next question asks if you would like to print name tags when someone checks into a class, meeting or event. If you do, mark the option for Yes.

Next, you’ll be asked if you’d like to print a parent tag. If you would like to print a security tag that can be used for pickup, answer Yes.

Once you’ve gone through these steps, you will now be able to use the check in system. If you need to further refine the options for your check in users, customize what you’d like printed on the name tags or choose a different size label size, you’ll want to go to the Set up menu under CheckIn/Out to make those modifications.

Using the Setup Menu

The second method for setting up the check in system is to use the Setup menu under the CheckIn/Out menu on the left side. This method will give you the most options when configuring your check in users, name tags, groups and keytags.
The following sections will walk you through the different sections of the Setup Menu.

**User Security and Check In Users.**
To use Roll Call’s child check in/out system you must “sign into” the system as a check in user. The type of user determines the screens you will see. So the first thing you will need to do to activate the security system is to set up the “check in” type users.

**Activate Roll Call Security**
To activate the security system with in Roll Call you must give the Director/Administrator user a password. To do this:
1. Expand the Check In/Out menu.
2. Click on the Setup menu item.
3. Enter the password you’d like to give to Director. Then re-enter that password to confirm.
4. Click SAVE. Make sure to save this password before you click NEXT to go to the next step in the process.

**Create Check In Users**
After you’ve entered the Director password and clicked NEXT, you will be at the window to add check in users. To add a check in user, click on the plus sign in the lower left of the window. Enter the following information:
1. **Username** – enter the name for this specific check in user.
2. **Password** – enter a password for this specific user or leave it blank.
3. **Confirm** – re-enter the password if you entered one.
4. **Check In User (Client)** – make sure to mark this option if the user will be logging into a computer check in station.
5. **Check In User (Mobile)** – mark this option if you are creating a user that will be logging into a mobile device to perform check in through our Mobile Check In add-on.

6. **Print Queue User** – mark this option if you are creating a print queue user that will manage the nametag print jobs for mobile check in.

7. Click OK to save this user.

You are now taken to the window to select the properties for this check in user.

**Check In User (Client) - Options**

If you are creating a check in user that will be used on a computer check in station, there are a variety of options that will affect what is displayed on the screen and how the check in station operates.

There are three tabs with different options. The Permissions tab allows you to define how the check in user will operate. The Check In Options tab will allow you to define which events/classes/groups are available to check into. The Appearance tab allows you to define color schemes, background image and logo.

On the Permissions tab, choose the following:

*Self Check In* – if the check in user has “self check in” marked, this user will not be able to view any address information from the people list screens. This user will not be able to print the check in roster or exit the program without a password. Use this option for “unmanned” stations.

*Dashboard* – if this option is marked, the check in screen will include a tab called Dashboard. When the user clicks on the Dashboard tab they will be able to view how many people have checked into each class today. They can further drill down and see who is checked into each class. We recommend using this option only for “manned” stations.

*Default Campus* - if system preferences are set to allow multiple campuses, each check in user can have a default campus defined. This means that the user will only be able to check into groups/classes/services that are from that campus. For example, if the check in user has a default campus “Southside”, they will only see groups that also have Southside as the campus.

Mark the options you’d like for this check in user.
Touch screen – if the check in user has “touch screen” marked, a virtual keyboard will be displayed on the screen.

Rapid Check In – if the check in user is marked as “rapid check in” and you are checking in by “individual” and the student is only enrolled in one class that is meeting that day, the system will automatically check them into that class.

Check-Out – if the check out option is marked, then that user can also check students out through the system.

Add Visitor – if the add visitor option is marked, there will be an ADD VISITOR button on the check in screen. This will allow the user to enter basic information about the visitor and check them into the appropriate class or meeting.

Edit Profile – if the edit profile option is marked, an EDIT PROFILE button will be included on the Options page so that the user can update a person’s profile information. For example if a student needed to update their email or address, this could be done through EDIT PROFILE.

Check In Using – if you are not using a bar code scan or fingerprint scan to identify who is there to check in, you will need to identify them based on their last name, last four digits of the phone number or the family number.

Return Families or Individuals – if you are doing a bar code scan or fingerprint scan and have “return by family” checked, a list of all the family members will be returned when you perform the scan. If you are searching by name, phone or family number, a list of families will be returned that meet the entered criteria. Then the user will need to highlight the appropriate family. Next a list of family members will be presented so you can choose the ones that will be checking in.

If you are doing a bar code scan or fingerprint scan and have “return by individual” checked, only the person assigned that bar code number (or fingerprint) will be returned. Typically you would use this to check students into a youth group or adult class.

If you are searching by name, phone or family number and have “return by individual” checked, a list of people that meet that criteria will be displayed. For example, if you search by name and enter “Smith”, a list of everyone who has the last name “Smith” will be returned. You can highlight one or more from the list to check them in.

List Only Children – if you are using the system to check kids into your Children’s Ministry or Daycare, you can limit the name that are returned to “only children”.

The Check In Options tab allows you to set which groups/classes will be displayed when the user hits the EDIT button. The different options are as follows:

- Only show groups/classes a person is enrolled in. This option will limit check in to only those classes that a child is pre-enrolled in or to recommended classes based on the age or grade range in the group definition.

- Only show groups/classes currently available. This option will limit check in to those classes that are currently meeting within the check in timeframe window.

- Show all groups/classes meeting today. This option will allow check in, into any classes/groups that are meeting today.
- *Show only specified groups/classes.* This option will allow you to choose the specific classes/groups that are available.

The Appearance tab allows you to set what the check in screen will look like. Your options are:

*Check In Header* – Enter the heading you’d like displayed on the Check In Screen as well as the Header font, size and color.

*Check In Image* – Click on the plus sign to pull in your logo as the check in image. This image will be displayed in the upper left of the check in screen.

*Background Image* – Use the drop down to select a stock photo as your background image. Or use the plus sign to pull in your own image.

*Background Color* – Select the color you’d like as the background on the check in screen if you did not choose a background image.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE & CLOSE button.
Check In User (Mobile) - Options

If you are creating a check in user that will be used on a tablet or smartphone, there are a variety of options that will affect what is displayed on the screen and how the check in station operates. The Permissions tab allows you to set the options for how the check in station will operate.

**Self Check In** – if the check in user has “self check in” marked, this user will not be able to view any address information from the people list screens or edit profile information.

**On Screen Keyboard** – if the check in user has “On Screen Keyboard” marked, this will create a virtual keypad for the option to checkin using Search by Phone only.

**Dashboard** – if this option is marked, the check in screen will include a tab called Dashboard. When the user taps on the Dashboard tab they will be able to view how many people have checked into each class today. They can further drill down and see who is checked into each class. We recommend using this option only for “manned” stations.

**Default Campus** - if system preferences are set to allow multiple campuses, each check in user can have a default campus defined. This means that the user will only be able to check into groups/classes/services that are from that campus. For example, if the check in user has a default campus “Southside”, they will only see groups that also have Southside as the campus.

**Check-Out** – if the check out option is marked, then that user can also check students out of their classes through the system.

![Image of check in user options](image-url)

Mark the options you’d like for this check in user.

**Add Visitor** – if the add visitor option is marked, there will be an ADD VISITOR button on the check in screen. This will allow the user to enter basic information about the visitor and check them into the appropriate class or meeting.

**Check In Using** – Indicate if you will pull up students based on their name or phone number. With mobile check in users you can also check in by group, keyword, service or event (for more information on events see the Event Checkin Manual). If one of these options is chosen the system will present a list of people enrolled in that group/keyword or service and the user simply marks who is present.
Return Families or Individuals – If you select return families, a list of families will be returned with that have that last name or phone number. If you select return individuals, a list of individual people with that last name or phone number will be returned.

List Only Children – if you are using the system to check kids into your Children’s Ministry or Daycare, you can limit the name that are returned to “only children”.

Default Print Queue – Select which print queue the name tags and parent tags should go to for this mobile check in user. For example, let’s say we have some one checking in on the lower level with an iPad and another user checking in students on an iPad on the upper level. You can have two different printers … one on the lower level and one on the upper level. These printers will be defined as print queue users. You must associate the printer for each mobile user.

Choose which groups/classes should be displayed when you press EDIT.

The Check In Options tab allows you to set which groups/classes will be displayed when the user hits the EDIT button. The different options are as follows:

- **Only show groups/classes a person is enrolled in.** This option will limit check in to only those classes that a child is pre-enrolled in or to recommended classes based on the age or grade range in the group definition.

- **Only show groups/classes currently available.** This option will limit check in to those classes that are currently meeting within the check in timeframe window.

- **Show all groups/classes meeting today.** This option will allow check in, into any classes/groups that are meeting today.

- **Show only specified groups/classes.** This option will allow you to choose the specific classes/groups that are available.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE & CLOSE button.

**Check In User (Print Queue) - Options**

If you are using Mobile CheckIn and would like to print nametags and parent tags, you’ll need to create a least one print queue user. There are two types of print queue users:
1. Local print queue. With a local print queue you need to have a Dymo printer connected via USB to a computer that is running Roll Call and logged in as this print queue user.

2. Remote print queue. An example of a remote print queue would be a brother wireless printer. The brother printer driver must be installed on a computer that is logged into Roll Call.

Default Campus - if system preferences are set to allow multiple campuses, each print queue in user can have a default campus defined.

Once you have selected all the information necessary for your check in user, make sure to press the SAVE button.

**Name Tags & Parent Tags**

Use the “tags” section to set your preferences for printing name tags and parent tags. Once you hit next from the check in user screen, you will be asked if you want to print name tags upon check in. If you do, click Yes. Click NEXT

Next, you’ll be asked which size you’d like to use. We support 2 sizes. The 30256 is the larger shipping size label. The 30334 is a smaller multi-purpose label. You may also choose to create a custom label here. Make your selection, then click NEXT.

The next window asks if you’d like to print a parent tag for children. The parent tag lists only the security number that matches the child’s name tag. Parent tags are only printed for people in the database whose family position is Child.
Choose the size labels you’ll be using for name tags and parent tags.

If you choose to print parent tag, choose the security number you’d like to use.

Also on the screen you may indicate the number you’d like to use as the security number on the name tag and the parent tag. You may choose from the family number, a random security number that uses numbers and characters or a random security number that is strictly numbers. Click NEXT.

From this window, select the information you’d like printed on the child’s name tag.

1. **Logo** – if you are using the 30256 size labels, you can print a ministry logo in the upper left of the label. You don’t want this logo to be a super high resolution logo or it will take a long time to print.
2. **Barcode** – some churches print the barcode on the label itself for easy check out.
3. **Security number** - choose the security number you’d like printed on the child’s name tag. The badge number is not allowed if you will be printing parent tags. The badge number uniquely identifies the child. The family number is a number assigned to the family in roll call. The random security number is randomly determined by the system. The random number will change from week to week. The badge number and family number will not change from week to week.
4. **Allergies** – any allergies listed in the “Special Needs” comment section will be displayed on the name tag if this is checked.

5. **Last Name same size as First** – By default the first name is in a larger font that the last name. If you’d like them to be the same size, check this box.

6. **Session Time or CheckIn Time** – You can choose to print the class start time (session time) or the actual time that the child checked into the class on the name tag. Mark your selection.

When you’ve checked the options you’d like for the name tag, click NEXT to choose a logo for Youth and Adult name tags. The youth and adult name tags will only include their name, the date of the event and the group they are checking into. There is no security number, barcode or allergy information printed on an Adult tag.

To add a logo for the Youth/Adult tag, click the box for logo. Click the ADD IMAGE button and navigate to that image file. Click NEXT to continue through the check in set up process.

At this point you may want to install your Dymo printer and run a test label to make sure everything looks okay. Once you have the printer installed, click on the PRINT TEST button. If everything prints okay, click NEXT to continue through the set up process.

**Check In Preferences**

The check in preferences allow you to set the “check in timeframe”. You can set the number of minutes before a class, event, worship service starts you’d like to begin the check in process. You can also set the number of minutes before a class ends that you will no longer allow anyone to check into that class.

As an example, let’s say we have a Sunday school class that meets from 9:30 to 10:30, if we set our beginning time to 30 minutes before, we can begin checking kids in at 9:00 a.m. In this same example if we set the ending minutes to 15, we could check students into that class until 10:15. At 10:15 we would no longer see this class in our list of classes to check into.

On the Preferences screen you can also set the default association for visitors. This will be the association that is used in the ADD VISITOR screen.
Enter the number of minutes before a class starts to begin check in.

You may also customize the text on the Options screen. Enter that text in the field for *Welcome Screen Text*.

**Groups**

To use the child check in functionality, there must be something to check into. You can check people into Groups or Services. The Groups area in Roll Call is where you would set up your Sunday school classes, VBS, membership classes etc. The Services area is where you set up your worship services. Each group that you will be checking into must have at least 1 session. A session is the day and time that it meets. For example, if you had a first grade Sunday school class that meets at 9:30 and 11:00, those times would be the session.

Click the plus sign to add groups. Make sure to enter name, sessions and grade/age range for class.
To add a group through the check in setup area, click on the plus sign in the lower left corner. You are now at the window to add a group. For more details on creating groups, see the “Creating Groups” chapter in this manual.

People

You will also need to have at least your children entered into the system and enrolled into their classes to use the check in system. To enter people through the check in setup area, click the plus sign in the lower left corner. You are now at the people entry screen. For more details on entering people, see the “Entering People” chapter in this manual.

Uncheck Auto Assign when assigning your own barcode numbers (from keytags) using barcode scanners.
Key tags

If you will be ordering key tags for use with the Roll Call child check in system, click NEXT from the People list in the set up process or click on the Key tags graphic. The first window asks if you’ll be using Key tags. If so, answer yes. If not, answer no. Make sure the Auto Assign at the bottom of the page is unchecked when assigning your own barcodes using keytags.
To assign a key tag to a person, highlight their name in the list. Click on their barcode number (assigned by roll call) Once that number is highlighted, scan the key tag. This will assign the new number to this person.
CUSTOMIZING CHECK-IN LABELS

If you would like to use a label size other than the 30256 or the 30334, you will need to create a custom label. If you’d like additional information on the name tags that is not included on the standard 30256 or 30334 labels, you’ll need to create a custom label.

If you choose to customize your labels, you’ll need to customize the parent tag, child tag and adult/youth tag.

Set the Label Size

In order to customize your check-in labels you must go into the Check-In/Out setup wizard from the Navigator screen.
1. Click on the Tags icon.
2. Answer Yes to the question “Do you want to print tags?”
3. Click NEXT.
4. Mark the Label Size option Custom.
5. Choose the Label Size you will be using. If you will be adding information to the 30256 or 30334 labels, you’ll need to select that size in the custom area.
6. Choose Portrait or Landscape (this will depend on your label size and orientation).
7. Click NEXT.

Customize the Parent Tag

If you have marked the option to create custom labels, you will need to also customize the parent tag. From this window, answer “Yes” if you wish to print a parent tag. Next choose the security number you’d like to use on the parent tag. Once you’ve made those selections you may begin defining your parent tag.
1. Click CUSTOMIZE PARENT TAG.
2. The canvas and object library windows are displayed. The canvas is used to layout the tag and position the fields on the tag. The object library contains all the available fields that can be used on the canvas.
3. To create the parent tag, define the canvas, place fields on the canvas, and format the fields.
4. Click SAVE icon to save the parent tag definition.
Define the Canvas
Before you begin dragging and dropping fields onto your canvas, you’ll want to:
1. Set the page size.
2. Place your markers.
3. Outline the upper left quadrant with a box. This makes it easy to see the area you have to work in.

Click on the page size icon. This will allow you to set the page size and orientation.

The canvas area that represents the label is the upper left quadrant. If any objects are placed outside of that quadrant, multiple labels will be printed.

Next you’ll need to place your markers at the appropriate height. The markers are the lines that go horizontally across the canvas. They have an arrow on the right side of the grid. If you don’t see the markers, right mouse click on the canvas and select Display>Markers.

There are three markers: Detail, Break and Footer. All three of these markers need to be set just above the line, which represents the bottom of the label. If these markers need to be moved, click on the arrow then drag to the appropriate position. Do not place fields below these lines.
You may wish to draw a box around the area on the canvas where you can place fields. This makes it much easier to see the area that you’ll be using. Click on the box icon on the left side of the canvas. Place your cursor in the upper left of the label area and drag it to the lower right area of the label area. You now have a white area in the upper left quadrant that represents the area that you can place fields.

**Place Objects**
You may place static text, images or data from the object library on your canvas.

To place static text onto the canvas, click on the Text tool on the left side of the canvas. Now draw a text box on the canvas. Enter your text. You may use the property box on the right to modify the size and font of the text.

To place an image on the label, open the image file in a previewer, copy it and paste it on the canvas. You can then resize it and move it where you’d like it. Please note, if your image is a large high-resolution image, it can slow down your printing time.

To place data or system information, drag the applicable field from the object library onto the canvas. To change the size or font of the data, select the field on the canvas, and use the property box to change size and font.
To align fields on the canvas, use the alignment tool on top of the canvas to center, align left or align right. Fields that would make sense to include on the parent tag would be *Current Date*, *Family Number*, or *Security Code*. A full list and descriptions of the fields available in the Object Library can be found in Appendix A.

**Save Parent Tag Definition**

Once you’ve created your parent tag, click the SAVE icon to save your customizations.
Test the Parent Tag

After saving your definition, you’ll want to test it. Close the canvas window. Click PRINT TEST LABEL. If everything prints okay, click NEXT to move on to the customization of the child tag. If the parent tag did not print properly, click CUSTOMIZE again to make necessary corrections.

Customize the Child Name Tag

Once you’ve completed the customization of the parent tag, you can move on to customize the child’s name tag. From this window, you can set your security number, customize the tag and test the tag.

1. Click CUSTOMIZE CHILD TAG.
2. The canvas and object library windows are displayed. The canvas is used to layout the tag, as well as position fields on the tag. The object library contains all the available fields that can be used on the canvas.
3. To create the child tag, define the canvas, place fields on the canvas, and format those fields.
4. Click SAVE icon to save the child tag definition.

Define the Canvas

Before you begin dragging and dropping fields onto your canvas, you’ll want to:

1. Set the page size.
2. Place your markers.
3. Outline the upper left quadrant with a box. This makes it easy to see the area you have to work in.

Click on the page size icon. This will allow you to set the page size and orientation.
Click on page set up icon.

Select your Dymo Printer and Label Size.

The canvas area that represents the label is the upper left quadrant. If any objects are placed outside of that quadrant, multiple labels will be printed.

Next you’ll need to place your markers at the appropriate height. The markers are the lines that go horizontally across the canvas. They have an arrow on the right side of the grid. If you don’t see the markers, right mouse click on the canvas and select Display>Markers.

There are three markers: Detail, Break and Footer. **All three of these markers need to be set just above the line, which represents the bottom of the label.** If these markers need to be moved, click on the arrow then drag to the appropriate position. Do not place fields below these lines.

You may wish to draw a box around the area on the canvas that you can place fields. This makes it much easier to see the area that you’ll be using. Click on the box icon on the left side of the canvas. Place your cursor in the upper left of the label area and drag it to the lower right area of the label area. You now have a white area in the upper left quadrant that represents the area that you can place fields.
Click on “draw box” icon.

Draw box on canvas to represent the area where you can place objects.

**Place Objects**
You may place static text, images or data from the object library on your canvas.

To place static text onto the canvas, click on the Text tool on the left side of the canvas. Now draw a text box on the canvas. Enter your text. You may use the property box on the right to modify the size and font of the text.

Click on Text tool.
Enter your static text.

To place an image on the label, open the image file in a previewer, copy it and paste it on the canvas. You can then resize it and move it where you’d like it. Please note, if your image is a large, high-resolution image, it can slow down your printing time.

Object library. Lists all data that can be printed on tag.

Drag field from object library onto canvas.
To place data or system information, drag the applicable field from the object library onto the canvas. To change the size or font of the data, select the field on the canvas, then use the property box to change size and font.

To align fields on the canvas, use the alignment tool on top of the canvas to center, align left or align right. A full list and descriptions of the fields available in the Object Library can be found in Appendix A.

**Highlight all the fields on the canvas.**

**Use the alignment tool to align left, right, center.**

---

**Save Child Tag Definition**

Once you’ve created your parent tag, click the SAVE icon to save your customizations.

---

**Test the Child Tag**

After saving your definition, you’ll want to test it. Close the canvas window. Click PRINT TEST LABEL. If everything prints okay, click NEXT to move on to the customization of the adult/youth tag. If the child tag did not print properly, click CUSTOMIZE again to make necessary corrections.

---

**Click to test the label.**
This is a bit of a trial and error process. Once everything is working, you will want to delete the box outline around the objects on the canvas. Highlight the box and click the delete key on your keyboard. Make sure only the outline is highlighted, not all the objects within the box.

**Customize the Adult/Youth Name Tag**

Once you’ve completed the customization of the child tag, you can move on to customize the adult/youth name tag. From this window:

1. Click CUSTOMIZE ADULT TAG.
2. The canvas and object library windows are displayed. The canvas is used to layout the tag, as well as position fields on the tag. The object library contains all the available fields that can be used on the canvas.
3. To create the adult tag, define the canvas, place fields on the canvas, and format those fields.
4. Click SAVE icon to save the adult tag definition.

**Define the Canvas**

Before you begin dragging and dropping fields onto your canvas, you’ll want to:

1. Set the page size
2. Place your markers
3. Outline the upper left quadrant with a box. This makes it easy to see the area you have to work in.

Click on the page size icon. This will allow you to set the page size and orientation.

The canvas area that represents the label is the upper left quadrant. If any objects are placed outside of that quadrant, multiple labels will be printed.

Next you’ll need to place your markers at the appropriate height. The markers are the lines that go horizontally across the canvas. They have an arrow on the right side of the grid. If you don’t see the markers, right mouse click on the canvas and select Display>Markers.

There are three markers: Detail, Break and Footer. **All three of these markers need to be set just above the line, which represents the bottom of the label.** If these markers need to be moved, click on the arrow then drag to the appropriate position. Do not place fields below these lines.
Click on marker arrow to move up or down.

You may wish to draw a box around the area on the canvas that you can place fields. This makes it much easier to see the area that you’ll be using. Click on the box icon on the left side of the canvas. Place your cursor in the upper left of the label area and drag it to the lower right area of the label area. You now have a white area in the upper left quadrant that represents the area that you can place fields.

Click on “draw box” icon.

Draw box on canvas to represent the area where you can place objects.

Place Objects
You may place static text, images or data from the object library on your canvas.

To place static text onto the canvas, click on the Text tool on the left side of the canvas. Now draw a text box on the canvas. Enter your text. You may use the property box on the right to modify the size and font of the text.

Click on Text tool.

Enter your static text.
To place an image on the label, open the image file in a previewer, copy it and paste it on the canvas. You can then resize it and move it where you’d like it. Please note, if your image is a large, high-resolution image, it can slow down your printing time.

To place data or system information, drag the applicable field from the object library onto the canvas. A full list and descriptions of the fields available in the Object Library can be found in Appendix A.

To change the size or font of the data, select the field on the canvas, and use the property box to change size and font. If you don’t see the property list, double click on the field on the canvas.

To align fields on the canvas, use the alignment tool on top of the canvas to center, align left or align right.
Save Adult Tag Definition
Once you’ve created your adult tag, click the SAVE icon to save your customizations.

Test the Adult/Youth Tag
After saving your definition, you’ll want to test it. Close the canvas window. Click PRINT TEST LABEL. If everything prints okay, you are done with customizing the labels. If the tag did not print properly, click CUSTOMIZE again to make necessary corrections.

This is a bit of a trial and error process. Once everything is working, you will want to delete the box outline around the objects on the canvas. Highlight the box and click the delete key on your keyboard. Make sure only the outline is highlighted, not all the objects within the box.

Customize Visitor Check In Screen
Roll Call now has the flexibility to customize the Add Visitor screen when checking in by Individual. Crucial information can be entered right when the person’s profile is first added to the system or can be edited for an existing profile.

Step One-Create a user that has the ability to Check In by Individual
Go into Checkin/Out and select SETUP. Click on the Add+ sign and select Check In Client. Select the option Check In by Individual. Once you do that, a customize button pops up on your screen. Select the Customize Add Visitor option. Come back to this area to choose your custom fields after following steps two-four. You will need to log in as this check in user in order to use your Customized Visitor Check in option.
Step Two-Define your Custom Fields/Checkboxes and Dates

Only custom fields that have been given titles will be available to be included in the Add/EditProfile screen. This can be done in Roll Call Preferences > People. Click on the Custom tab to define the Custom Fields, Checkboxes and Dates. Custom fields default to having a drop down list for the user to be able to select from. If you want the user to be able to type in free text then click to turn the Select List Off for that particular custom field. The Add Visitor screen only allows users to select from existing drop down values if that is the type of custom field defined. Please note that if you ever clear out the title of a custom field (essentially turning it off), this does not remove any data in that field or remove it from being used in any existing check-in users where it was defined. You would need to remove it from each check-in user where it is defined.
**Step three - Define your Custom Field drop down values**
There are two ways to define custom field values: 1) From Lists Maintenance and 2) From a person’s profile (if you have Edit Lists permissions). This focuses on option 1. To manually enter values for each drop down go to Administration > Lists and select the custom field. Add the values you want and don’t forget to click to Save.

**Step four - Customize the Check-in Add Visitor screen for your Check-in User**
Each check-in user that has been defined as check-in by Individual can have a customized Add Visitor screen defined. To customize, go to Administration > User Security and select the checkin user or add a new check-in user. Click on the Customize tab.

By default, “Use default Add Visitor screen” is selected. If you want to customize the Add Visitor screen, click “Customize Add Visitor Screen by adding defined custom fields”. All of the available (defined) custom fields are displayed. You can drag and drop the fields from Available to Selected. You can also set the order that the selected fields will appear on the screen by dragging and dropping them within the Selected list. In this example there are no custom fields under Available because all of the defined custom fields have all been selected.
Add Visitor - Check-in by Individual (not customized)
If you don’t customize the Add Visitor screen for the check-in user, when you click Add Visitor the following screen is displayed. Once you complete the information the person is added and you may check them in.

Add Visitor - Check-in by Individual (customized)
If you customize the Add Visitor screen for the check-in user, when you click Add Visitor the following screen is displayed with any custom fields added to the bottom. The height of the Add Visitor window will be based on the height of your check-in window. On windows this is the size of the screen by default. On Mac the screen may be resized. The Add Visitor window height will automatically be adjusted based on the height of the check-in window. If the screen size isn’t large enough to completely display everything, a scroll bar to appear on the right. The user may scroll down to get to the fields that can’t be displayed on the screen.

In this example the Add Visitor window isn’t big enough to display all of the fields so a scroll bar is displayed. Notice the custom fields are displayed at the bottom.
In this example, the size of the check-in screen is taller so the Add Visitor window is taller and a scroll bar isn’t necessary. Notice the different types of custom fields in the example below. There are two custom fields with drop downs to select values, two custom fields which allow free form text entry, two custom checkboxes and two custom date fields. The custom fields are arranged left to right - top to bottom.
MANAGING GROUPS FOR CHECKIN

A group in Roll Call is a class, event, group or meeting that you will be checking people into. This chapter focuses mainly on the areas of groups that you will need to know for the check in system. For a full explanation of groups, please see the “Managing Groups” chapter in the Roll Call User Manual.

Add a Group through the Setup Assistant

The Setup Assistant is a series of screens that will be presented when you first start using Roll Call. If you indicate that you will be using the CheckIn System you will be given the opportunity to add basic information about the group.

When you get to the Check In Groups window, enter the following information:

1. **Name** – the name of the group you are setting up.
2. **Day** – the day of the week that the class, meeting or event happens.
3. **Start Time** – the time that the class, meeting or event begins.
4. **End Time** – the time that the class, meeting or event ends.
5. **Grade or Age** – is this class, meeting or event limited to people in a certain grade or age range. If so, choose Grade or Age.
6. **Grade range** – if the class if for students in a certain grade, enter the “from” and “to” grade.
7. **Age range** – if the class is for students of a certain age range, enter the “from” and “to” age.

Add a Group through the Navigator Menu

The Add a Group screen will allow you to add more detailed information about a group. To get to this window:

1. Expand the Groups menu and click Add a Group OR
2. Expand the Groups menu and click Search. Click on the plus sign in the lower left to add a new group.

Once you are in the screen to add the group:

1. Enter the values for **Campus (if applicable)**
2. Enter the **Group Type**. This type is a high level category for the classification of the group. Is it a class, event, small group, etc.? 
3. Enter the **Department or ministry area** that is responsible for this group.
4. Enter the **Group Name**.
5. If the group has a leader, enter the last name in the Leader field. Press tab to view a list of the folks with that last name. You can make the leader a member of the group so you can check them into this class.

6. If the group has a co-leader, enter the last name in the Co-Leader field. Press tab to view a list of the folks with that last name. Select from the list.

7. Select the Frequency to indicate if the group meets weekly or randomly.

8. The field “When does this meet?” is the information that is displayed in Roll Call Connect for when the group meets. PLEASE NOTE: This information is not used by the check in system. You need to enter sessions for child check in to work properly.

9. Enter the Location of the group if applicable.

10. Enter the Address that will be displayed in Roll Call Connect for the meeting location.

11. The Start Date will default to today’s date. You may change it if you’d like.

12. Enter the End Date if you know the last day this group will meet. Keep in mind that on this date the system will change that group to inactive.
Click SAVE & CLOSE to save the information and return to the Search screen. Click SAVE & NEW to save the information and enter a new group.

Add Members
When a person is a member of the group, they can be checked into that group through the check in system. To enroll people into the group, press the Members tab. From within the members tab:
1. Click the plus sign in the lower left of the window. A new window will be displayed for you to enter the Last Name and First Name (or portion of the last name) of the person you want to enroll.
2. Select the appropriate person to enroll in the group.

Create sessions
Next, you’ll want to indicate which days and at what times the group meets. This is mandatory for the check in system. The system needs to know what days and times the group is meeting so it knows what it can check people into.

To create a session:
1. Click on the session tab, if sessions are not currently displayed.
2. Click on the plus sign in the lower left. A row will be displayed, with a default of Sunday and time of 12 a.m.
3. Use the Day of Week drop down box to select the appropriate day.
4. Enter the Start Time.
5. Enter the End Time.
6. Place your cursor under Room and double click to enter the room number of this group meeting. Room will be printed on the name tag.
Click on plus sign, then update meeting date and times.

Preferences
Use the preferences tab in the group screen to set your check in label preferences and grade/age range preferences.

Enter the grade range or age range that is applicable for this group. This information will be used to recommend classes in the child check in system. It will also be used in the Graduation utility.

1. From Age (Years & Months) - Enter the beginning age that a child is allowed in this class/group.
2. To Age (Years & Months) – Enter the oldest age that a child is allowed in this class/group.
3. From Grade – Enter the beginning grade that a child is allowed in this class/group.
4. To Grade – Enter the last grade that a child is allowed in this class/group.

Enter the following check in system preferences for this specific class or group. From Age (Years & Months) - Enter the beginning age that a child is allowed in this class/group.

1. Number of Labels – Enter the number of nametags you’d like to print when a person checks into this group.
2. Print Tag on Check Out – Mark this box if you’d like to print a name tag when the child checks out of this class.

Enter label preferences for the check in system.

Enter grade OR age ranges for this class/group.
**Graduation**

There are 3 different methods for graduating children from one class to the next:

1. **Graduation Profile** – This method works great for classes that are grade specific and only cover one grade. You can create a map of how the classes graduate, then click GRADUATE NOW.

2. **Birthday Graduation** – Use this method if the children should move up on their birthday.

3. **Graduation Utility** – This method works great if you have the grade included in the child’s profile. It also handles the situation where a class covers multiple grades, for example a class that includes 3rd through 5th graders.

**Graduation Profile**

If you have a series of classes that you need to graduate at the beginning or end of the school year, do the following:

To create this “pre-school” graduation profile, do the following:

1. Click on Graduation under the Groups menu.
2. Click on the plus sign to add a profile.
3. Select the Department and Group Type for your “School Age” classes.
4. Give this graduation profile a name. In this example, I’ll call it Grade School.
5. Click the plus sign in the lower left to set up the first graduation from Kdg to 1st grade. Select Kdg from the “from” box and 1st grade from the “to” box. Click SAVE & NEW or SAVE & CLOSE.
6. Continue this process until all your school age classes have been identified.

When you are ready to actually do the graduation, do the following:

4. Expand the Groups menu.
5. Click on Graduation.
6. Double click on the profile you wish to graduate.
7. Click GRADUATE NOW.
8. A log will be displayed showing the graduation process.

**On Birthday**

There may be cases where you want a child to automatically move to the next class on their birthday. In this example let’s say we have a Nursery class for kids 0 – 2 years and a 3 year old class, and a 4 – 5 year old class. For these classes we want the child to graduate on their birthday.

To create this “pre-school” graduation profile, do the following:

1. Make sure you have the age ranges set in the Preferences tab of each group.
2. Next, click on Graduate under the Groups menu.
3. Click on the plus sign to add a profile.
4. Select the Department and Group Type for your “pre-school” classes.
5. Give this graduation profile a name. In this example, I’ll call it Pre-School.
6. Click the plus sign in the lower left to set up the first graduation from 0-2 to 3 year olds.
   Use the drop down to select the from class. Use the drop box to the right to pick the to class.
   Click SAVE & NEW or SAVE & CLOSE.
7. Continue this process until all your pre-school classes have been identified.
8. When you are back at the graduation profile window, click on the box to graduate on Birthday.

**Graduation Utility**

If you have the child’s grade in their profile information and you’ve set the grade range in the group’s preferences, you can use the graduation utility to move children when it is time to graduate. This utility will do two things:
1. It will change the grade in the child’s profile record. For example if the grade was set to 1, it will be changed to 2.
2. If the child is enrolled in a class that has the grade preferences set, it will move the child to the appropriate class. If the child was in the 1st grade class, they will be moved to the 2nd grade class.
To use the graduation utility, do the following:
1. Expand the Groups menu.
2. Click on the Utilities icon on the top bar.
3. Select Graduate by Grade.
4. The utility wizard will be presented.
5. Enter the date by which a child must turn 5 to be enrolled in Kindergarten.
6. Click NEXT through the steps.
7. A log will be displayed outlining the results of this process.
ADDING PEOPLE FOR CHECK IN

To check people into a group, class or event with the check in system, those people must first be added into your Roll Call database. This chapter discusses the basic information for adding a person into Roll Call. For a complete discussion of adding families, please see the “Adding Families” chapter in the Roll Call User Manual.

Import contact information

If you have contact information in a spreadsheet, the easiest way to get them into Roll Call is to use the Import utility. There are four different formats available. For the purposes of this manual we will discuss the two most flexible options.

To create the file that can be imported into Roll Call, open the spreadsheet, and save it in the file format “tab delimited text” file (*.txt).

One Row Per Person Custom

The one row per person means that there will be one row in the spreadsheet for each person in the family. If you have a family of four, there would be one row with the dad’s information including address. The second row would be the mom’s information including the address. The third row would be child1’s information. And the fourth row would be child2’s information. We pull the family together based on a match of the address information.

The custom format means that you can have the columns in any order you wish. The import wizard will allow you to map the columns in your file to the fields in Roll Call. This format also allows you to pull in custom fields.

To import this type of file, do the following:
1. Expand the People menu on the left sidebar.
2. Click on Import.
3. Choose the One Row Per Person Custom Format.
4. Click NEXT.
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church).

Enter the values that will be used for these fields if a value isn't present in the file.

Click LOAD FILE to bring in the data from your spreadsheet.

6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.
7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, then click OPEN.
9. In the lower section you will need to map the columns from your file to the fields in Roll Call. Click on the header [Skip] and choose from the list of available fields.
10. Once you’ve mapped all the fields, click FINISH in the lower right to process the import.

**One Row Per Family Custom**

In this file format, there will only be one row in the spreadsheet for each family unit. There will be a column for family name, husband’s name, wife’s name, child1 name, child2 name, etc.

The custom format means that you can have the columns in any order you wish. The import wizard will allow you to map the columns in your file to the fields in Roll Call. This format also allows you to pull in custom fields.

To import this type of file, do the following:
1. Expand the People menu on the left sidebar.
2. Click on Import.
3. Choose the One Row Per Person Custom Format.
4. Click NEXT.
5. Choose a Default Association. This is used if the record doesn’t have an association value. Association is the membership category (how are they involved in your church).
6. Choose a Default Family Position. This is used if the record doesn’t have this value. We allow Husband, Wife, Adult, Youth, Child and Other.
7. Enter the line number where the data begins in your file. For example, if you had headers in your file, the data probably starts on line 2. If you don’t have any headers, the data probably starts on line 1.
8. Click LOAD FILE and navigate to the file you want to import. Highlight it, then click OPEN.
9. In the lower section you will need to map the columns from your file to the fields in Roll Call. Click on the header [Skip] and choose from the list of available fields.
10. Once you’ve mapped all the fields, click FINISH in the lower right to process the import.

**Use Add a Family Screen**

The Add a Family screen is a great way to get the basic information about a family entered into Roll Call quickly. To use this screen:
1. Expand the People menu.
2. Click on Add a Family.

**Enter Family Information**

The top section of this screen is where you enter the common family information. Enter the following pieces of information:
1. **Type** - Choose either Family or Organization.
2. **Last Name** – Enter the last name for the family, or organization name if you are entering a business.
3. **Primary Phone** – Enter the home phone number for the family.
4. **Unlisted** – Mark this checkbox if the family wants the home phones unlisted.
5. **Alt Phone** – Enter a second home phone number if applicable for the family.
6. **Street** – Enter address line 1 of the family’s address.
7. **More Address** – Enter address line 2 if applicable. Typically an apartment or suite number.
8. **City** – Enter the city portion of the family’s address.
9. **State** – Enter the state portion of the family’s address.
10. **Postal Code** – The zip code or postal code portion of the family’s address.
11. **Do Not Send Mail** – Mark this box if the family does not want to receive mail from your organization.
12. **Unlisted Address** – Mark this box if the family wants their address unlisted.
13. **Family Email** – Enter the email address that should be used when sending “family” emails.
14. **Shepherd Area** – Indicate the person, deacon or zone that is responsible for this family.
Enter Family Members Information

Use the lower section to enter the information for each family member. Use the plus sign in the lower left corner to open up a row to add another family member.

1. **Family Position** - Choose Husband, Wife, Adult, Youth or Child to indicate their family position.
2. **First Name** – Enter the first name of the family member.
3. **Last Name** – If the family member has a different last name, enter it here.
4. **Date of Birth** – Enter the family member’s birthday. Make sure to enter a 4 digit year.
5. **Gender** – Select the appropriate gender for the family member.
6. **Association** – Select the appropriate association or membership status for this family member.
7. **Cell Phone** – Enter the cell phone number for this family member if they have one. Enter the last name for the family, or organization name if you are entering a business.
8. **Marital Status** – Indicate the marital status for this family member.
9. **Grade** – If the family member is in elementary, middle or high school, enter their grade. Values accepted are K – 12.

Once you’ve completed entering the information for a family, click:

1. **SAVE & CLOSE** to save the information and close the window.
2. **SAVE & VIEW** to save the information and go to the Family Details screen.
3. **SAVE & NEW** to save the information and clear the window.
4. **CANCEL** to close the window without saving the information.
Update Check In Settings

The check-in settings are pieces of information used by the check in/out system in Roll Call. To enter this information, click on People from the menu on the left sidebar. Search for the person that you need to update their information. Double click on their name. Click on Checkin Settings from the list on the left sidebar. From the General tab you’ll be able to access the following information:

1. **Allergies** – Any allergies or special needs that this child has. This information can be printed on the name tag and check in roster, when the child is checked into a class.
2. **Check In Alert** – The alert that should is displayed when this child checks into a class.
3. **Custody Comments** – Any pertinent custody information. This information is displayed on check out.

The Authorized Checkout tab lists all the adults that are allowed to check this child out of his/her class. The information included:

1. **Name** – The person who is allowed to check the student out.
2. **Relationship** – The relationship between this person and the child.
OPERATING THE CHECK IN STATIONS (Computer Stations)

Log into the Check In Station

To use the check in functionality of Roll Call, you need to log on with a username that is a check in user type user. To start Roll Call, double click on the Roll Call icon. The Login window is displayed. If you do not get the Login screen, that means the security system is not activated. You’ll need to give the Director user a password. See the chapter on “Configuring Roll Call for Check In/Out”.

Log into Roll Call as a “check in user”.

If you are already logged into Roll Call, but are in the back end of the program where you look up people and groups, you can get into the Check In portion, by expanding the check in/out menu, then selecting Launch. This will bring you to the Login window so you can login as a check in user.

Once you log in, you’ll be taken to the check in screen. This screen can look different depending on the type of check in user you’ve signed in as. These options are discussed more in the chapter on “Configuring Roll Call for Check In/Out.

Check In Using a Last Name

To check a family in, based on their last name, type the last name. You can also type the first few characters of the last name. Then press the enter key or press the SEARCH button. This can be

From the check in screen, enter the last name, then click SEARCH.
done with a keyboard or with the virtual keyboard on a touch screen monitor.
A list of families with that last name will be displayed. Highlight the family that is present to check in then press the SELECT button to get to the list of family members. If there is only one family with that last name the system will take you right to the list of family members. To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will

Double click on the family that is present. Or highlight family and click SELECT.

Click CHECK IN ALL to check in both kids. Note the classes they will be checked into.

To check in only one of these students, click on the check mark to the right of their name. Click CHECKIN
check in, press the CHECKIN button to complete the check in process. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.

**Check In Using a Phone Number**

To check a family in based on a phone number, enter the last four digits of their phone number and press the enter key on your keyboard or click the SEARCH button. The system will return a list of families that have those four digits in the primary phone, alternate phone, cell phone or work phone field for any member of the family. This can be done with a keyboard or with the virtual keyboard on a touch screen monitor.

A list of families with that phone number will be displayed. Highlight the family that is present to check in then press the SELECT button to get to the list of family members. If there is only one family with that phone, the system will take you right to the list of family members.

To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will check in, press the CHECKIN button to complete the check in process.
Enter last 4 of phone and press enter on your keyboard or click SEARCH.

Double click on the family that is present. Or highlight family and click SELECT.

Click CHECK IN ALL to check in both kids. Note the classes they will be checked into.
Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.
Check in Using a Bar Code

From the check in screen, scan the bar code from the keytag or bar code badge. If the check in user is set to “return by family” all the family members associated with this bar code number will be displayed.

To check in everyone listed, click CHECK-IN ALL. If you want to check in only certain children, click the checkmark to the right of their name. Once you’ve selected each child that will check in, press the FINISHED button to complete the check in process.

Click CHECK IN ALL to check in both kids. Note the classes they will be checked into.

To check in only one of these students, click on the check mark to the right of their name. Click CHECKIN.
Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. A listing of classes available for check in will be displayed. Mark the class(es) they should go to and click DONE.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button. A listing of all classes available for check in will be displayed. Mark each class you’d like to check the child into. Click DONE to return to the check in screen. Then click CHECK IN to complete the process.

If the check in user has “return by individual” set, only the individual associated with that bar code will be displayed. If that user also has “rapid check in” set, that individual will automatically be checked into their class.

### Check In Using a Touch Screen

To check in using a touch screen monitor, you’ll need to sign in using a check in user that has “touch screen” marked. For more information on setting up users, see the “Configuring Roll Call for Check In” chapter of this manual.
When you sign in as a check in user with the touch screen option, a virtual keyboard will be displayed on the screen. This will allows the user to enter a name or number using just the screen. Once they enter the criteria, they can press the SEARCH button on the screen instead of using the mouse. Once the lists are displayed, the process is the same as searching by name or phone.

**Check in Options**

**Check into Different Class**
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings and events that each person is enrolled in that are currently meeting. If you press the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into a different class:
1. Press the EDIT button.
2. The classes listed are dependent on your settings for this check in user.
3. Mark the class this student will be attending. Make sure to un-check the classes they were slated to attend.
4. Click DONE to return to the Check in screen.
5. Repeat for each family member.
6. Click CHECKIN from the list of family members to complete the check in process.

![Choose one or more classes to check this child into. Click DONE.](image)

**Check into Multiple Classes**
From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings or events that each person is enrolled in that are currently meeting. If you press the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into additional classes or events, do the following:
1. Press the EDIT button.
2. The classes listed are dependant on your settings for the check in user.
3. Mark each class you’d like to check this child into.
4. Click DONE to return to the check in screen.
5. Complete the check in process for all family members.
6. Click CHECKIN from the list of family members to complete the check in process.
Enter Allergy, Note, Custody Comment or Check In Alerts
If you need to record any notes, allergy, custody comments or check in alerts for a student, do the following:
1. From the list of family members, click the options button (looks like a pencil) to the right of the student’s name.
2. Mark the class the student will be attending.
3. Enter any notes for today. The notes will be printed on the name tag and check in roster. They are not stored in the database.
4. Any allergy information that is already in the database will be displayed. If you need to update or add to that information, make those changes on the bottom section of the option screen.
5. If there are any custody comments in the database for this child, they will be displayed at the bottom of the options screen. If you need to add custody comments or update existing custody comments do that here.
6. Enter any CHECK-IN Alerts at the bottom of the options screen.
7. Once you’ve entered this information, click CHECK-IN to check the child into their class and save the updated information.

Update Profile Information
If you are logged onto the check in system as a user that has “Edit Profile” privileges you will be able to update general contact information for this student. To make those changes:
1. From the list of family members, click on the options icon to the right of the student’s name.
2. Click on the EDIT PROFILE button at the top of the window.
3. Make any necessary changes.
4. Click SAVE & CLOSE to save these updates.
Assign a Barcode

If you are handing out keytags at the check in station, you’ll need to assign the bar code number to that person/family.

1. From the list of family members, click on the options icon to the right of the student or parents name.
2. Click on the ASSIGN BARCODE button at the top of the window.
3. Scan the keytag.
4. Click OK to save that assignment.
5. Click CANCEL to return to the check in page, or CHECK-IN to check in the parent or student into their class.
**Pull in a Picture**

You can import an individual’s picture through the options window. From the list of family members, click on the options button (looks like a pencil) to the right of the student you wish to import a picture for. Click on the plus sign underneath the picture area. Navigate to the their picture on your computer. Click OPEN.

**Add a New Person into an Existing Family**

If you need to add a person to a family that already exists in your database, do the following:
1. From the main check in screen enter the last name of the family then click SEARCH.
2. From the list of family members, click ADD TO EXISTING FAMILY button.
3. Enter the information for the new family member.
4. Click SAVE & CLOSE to save the information and return to the list of family members to check them in.
5. Or, click ADD ANOTHER to add another family member.
Check in Visitors

To check visitors into a class or group, click on the ADD VISITOR button. Enter the address and phone information if you’d like. Next enter the Mom and Dad’s information if you’d like to capture that. In the lower section enter the children’s names. You can enter up to four children through this screen. Click OK to save this information.
Enter the visitor’s information here. At a minimum, you must enter children’s info.

Now you will be at the screen to highlight those that are present to check in. If you’ve entered a grade or birthdate for each of those children and your classes have a grade/age range preference, you’ll see a recommended class for each child in the Checking Into column. If those are in fact the classes you want to check them into, click CHECK IN ALL.

If you’d like to check them into a different class, click on the options button (looks like pencil). Choose the class/classes you’d like them to check into, click CHECK IN.

Note recommended classes.

Click CHECK IN ALL to check them into these classes.
Check In by Individual Using a Last Name or Phone

The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

If you check in user is defined to “check in by individual”, you can type in the first few character of the last name, then a comma, then the first few characters of the first name or the last 4 digits of a phone number. Then press the enter key or press the SEARCH button. This can be done with a keyboard/mouse or with the virtual keyboard on a touch screen monitor.

A list of individuals that met the name or phone criteria will be displayed. Highlight the person that is present to check in then press the SELECT button to get to check in screen. If there is only one person that met the criteria the system will take you right to the check in screen.

A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

Mark the box to the right of the class you’d like to check them into. Click CHECKIN.
If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.

Choose from these options to view additional classes or edit data.

To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.

This is the window that pops up when you choose the option for Editing the Profile.
Check in by Individual Using a Bar Code

The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

If you are using a check in user that is defined as “check in by individual”, and you scan a barcode or fingerprint, the system will take you directly to the check in screen. A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

If your check in user is also set to “Rapid CheckIn”, and the student is only enrolled in one class that is currently meeting, the system will automatically check them into that class.

If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.

To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.
Check into Services

You can set Roll Call up so that you can check people into worship services. First you’ll need to define the Service. To do this expand the Service menu and click Add Service. Enter the following information:

1. **Name** - Give the service a name.
2. **Day** – Select the day of the week this service meets.
3. **Start Time** – Enter the start time of the service.
4. **End Time** – Enter the ending time of the service.
5. **Check in** – Mark this box to allow automated check in to this service.
6. **Labels** – Indicate if you want name tags printed when someone checks into this service.
7. **Associations** – Enter the association of people that can check into this service.
8. **Click SAVE & CLOSE** to save this service.

Once you have the services set up for check in, you can check people into those services using any of the methods listed above.

Create the worship service that you’ll be checking in. Make sure to mark box for check in.

Note worship service is now listed for check in.
Determine Headcounts

There are two methods for determining who is checked into a class.
1. The dashboard tab.
2. The check in roster.

Dashboard

If you are logged onto the check in station as a user that has “dashboard” privileges, you will notice a check in and dashboard tab on your screen. Click on the Dashboard tab to view the counts for each class. The total count is the number of folks who have checked into a specific class. The head count is the number of students who are still checked into the class.

To drill down and view the details of who is in the class, double click on the class name, or highlight the class and click DETAILS.

Check In Roster

The check in roster is a report for a specific class, which lists the students who have checked in. The information included on this report is the child’s name, parent’s name, allergy information, notes, custody comments and birthdates. This is a great roster to print off after check in so that your teaches know who they are responsible for.

To generate the check in roster, do the following:
1. From the check in screen, select Administration>Check In Roster from the top menu.
2. Highlight one or more classes that you’d like to print the roster for.
3. Click GENERATE.

If you are printing this from one of the check in stations, don’t forget to change the printer you are sending it to. You don’t want this report printing off on your DYMO!
Once you choose Administration> Check In Roster, you’ll be at this screen. Highlight one or more classes, then click GENER- 
ATE.

Sample roster. Lists children, parents, allergies, security code and birthdate.

Check Out

Compare tags

Once method of Checking the students out is to compare the security number on the child’s name tag with the security number on the parent tag. If the numbers match the teacher can release the child. Using this method, you will want to make sure to have policies in place to handle the circumstance where a parent looses the parent tag.
Using Check In Screen
You can also check students out through the Roll Call system. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Identify the student that is Checking out by scanning a tag or by searching name or phone.
3. Highlight the specific family.
4. From the list of family members, click the check mark in the Out column.
5. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is Checking the child out.
6. Make your selection and click CHECKOUT.

Using Dashboard
You can also check students out through the dashboard tab on the check in screen. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out this way:
1. Log onto Roll Call as a check in user that has “check out” and “dashboard” privileges.
2. Click on the dashboard tab.
3. Click on the by person tab.
4. Scroll through the list of students that are checked in to find the student you wish to check out.
5. Click on the check out button (looks like an open door).
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is Checking the child out. Make your selection and click CHECKOUT.
Sending Texts from Check In Screen

You can send texts from Roll Call’s check in system. To do this, you’ll first need to set up the texting preferences in Roll Call. There are two methods of sending texts from Roll Call. The first method is free and uses email to send the text. To use this method you will need to know the cell phone number plus the cell phone carrier. You will also need your Email Settings configured properly. The second method is to use the SMS Service from NexMo. Your church will need to set up an account with NexMo.

My Email Settings

If your organization will be using the Email method of sending Texts, make sure to configure the following settings:
1. Expand the File menu on the top.
2. Select My Email Settings.
3. Choose your preference for Plain Text or HTML emails.
4. Enter the Return Address. This is the “from” email address. If a recipient replies to the email this is the email address it will go to.
5. Enter the Mail Host Name. This is the Outgoing SMTP mail address required by your email provider.
6. Enter the Username and Password for this email account if your provider requires authentication.
7. Mark the box for the SSL if your provider requires SSL encryption.
8. Enter the Port Number, if your provider requires a specific port number.
9. Enter the No Emails/Minute. Your provider may throttle the number of emails that you can send per minute. If so, enter that number here.
10. Click SAVE to save these settings.

Once your email settings are configured, go to the Preference (under the Edit menu on Windows or the Roll Call menu on a Mac). Click on SMS Texting on the left sidebar. Choose the option to use Email.

NexMo Settings

If your organization will be using the SMS service from NexMo, make sure to configure the following settings:
1. Select Preferences from the Edit menu at the top (Windows machines) or the Roll Call menu (Mac machines).
2. Highlight SMS Texting from the left sidebar.
Each Roll Call user must set their own outgoing email host settings.

3. Select the option to use NexMo.
4. Enter the API Key provided to your organization by NexMo.
5. Enter the Secret Key provided to your organization by NexMo.
6. Enter the NexMo number that was provided to your organization.

From the SMS Texting preference choose your method of sending texts.

7. Enter any Msg Prefix. This will be in front of every text that is sent.
8. Click OK to save this information.

**Sending the Text**

Once you have your preferences and settings configured, you are ready to send a text. To send a text from the check in system, do the following:
1. Click on the Dashboard tab.
2. Find the student you need to send a text for.
3. Click on the text icon.
4. Choose who you will send the text to.
5. Type in your text message.
6. Click OK to send the texts.
Find your Numbers and API key from the NexMo dashboard.

Find student then click text icon.
Write text message.

Choose who you'd like to send text to.
OPERATING THE CHECK IN STATIONS (Tablets)

Log into the Check In Station
To use the check in functionality of Roll Call on a tablet, you must have a Mobile Check In license or activated the trial for Mobile Check In. You will need to get to the login screen from your tablet’s browser. Do that by entering the IP Address of your Roll Call Server machine as the URL in your browser.

From the login screen, enter the user name that you created as your mobile check in user. Enter the password for that user. Choose “Tablet” as your App Format.

Once you log in, you’ll be taken to the check in screen. This screen can look different depending on the type of check in user you’ve signed in as. These options are discussed more in the chapter on “Configuring Roll Call for Check In/Out”.

Customizing the Appearance
You can customize the graphic that is displayed on the background of the check in screens as well as the login in screen. To customize, do the following:
1. Once you are logged onto the check in system, click on the gear in the upper right.
2. On the Users Settings tab:
   a. Use the drop down to select a background image.
   b. Enter the Checkin Header Text. This is the name at the top of the check in window.
   c. Tap CHOOSE FILE under Custom Background image to pull in your own image file for the background image.
   d. Tap CHOOSE FILE under Custom Logo to pull in your organization’s logo that will be displayed in the upper right of the check in window.
3. On the Theme tab:
   a. Use the drop down to select a pre-set theme. Each theme will change button colors, outline colors, etc.
   b. To build your own theme, click on the SET THEME BUILDER to paste in your own CSS code.
4. On the Login tab:
   a. Use the drop down to select a background image for the login in screen.
   b. Tap CHOOSE FILE under custom image to pull in a custom image for your log in screen.
5. Tap SAVE to save these customization preferences.
Check In Using a Last Name or Phone Number

To check someone in based on the last name or phone number, first create a mobile user. If you want to use the virtual keyboard, be sure to select Search by Phone then ON SCREEN keyboard selected. Using the virtual keyboard, enter the last four digits of any phone number. Then tap the GO button. This virtual keypad only works with the phone option selected on Mobile. To check in by last name, select Search by Last Name or search by Last Name and Phone. You will have to type in the information from your own device rather than use the virtual keypad.
Double click on the family you'd like to check in. OR highlight the family and click SELECT.

Tap on the check-mark to check the child into the class listed.

A list of families with that last name will be displayed. Highlight the family that is present to check in then tap the SELECT button to get to the list of family members. If there is only one family with that last name the system will take you right to the list of family members.

From the EDIT screen you may choose to check into a different class or multiple classes.
To check in everyone listed, tap CHECKIN ALL. If you want to check in only certain children, tap on the checkmark to the right of their name. Once you’ve selected each child that will check in, tap on the CHECKIN button to complete the check in process.

Note the class that the child will be checked into is listed under the Checking Into column. If you would like to change which class the child will go to, click on the EDIT button. All classes that are currently available to check into will be listed. Mark the class they should go to and click DONE to return to check in window. Click CHECKIN to complete the process.

If the child is not enrolled in any classes that are currently meeting the Checking Into field to the right of their name will be blank. Click the EDIT button and choose the class you’d like to check them into. Click DONE to return to the check in screen. Click CHECKIN to complete the process.

**Check in Options**

**Check into Different Class**

From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings and events that each person is enrolled in that are currently meeting. If you tap the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into a different class:
1. Tap the EDIT button.
2. All classes that are currently available for check in will be listed.
3. Mark the class this student will be attending. Make sure to un-check the classes they were slated to attend.
4. Tap DONE button to return to the check in screen.
5. Repeat for each family member.
6. Click CHECKIN from the list of family members to complete the check in process.

**Check into Multiple Classes**

From the list of family members, you’ll notice the Checking Into column. This column will list the classes, meetings or events that each person is enrolled in that are currently meeting. If you tap the checkmark to the right of the person’s name, the system will check them into everything listed in that Checking Into column. If you would like to check them into additional classes or...
Enter all allergy and notes information in this section.

For check-in events, do the following:

1. Tap the EDIT BUTTON.
2. All classes that are available for check in will be listed.
3. Mark each class you’d like to check this child into.
4. Touch the DONE button.
5. Complete the check in process for all family members.
6. Click CHECKIN from the list of family members to complete the check in process.

**Enter Allergy, Note, Custody Comment or Check In Alerts**

If you need to record any notes, allergy, custody comments or check in alerts for a student, do the following:

1. From the list of family members, tap the EDIT button to the right of the students name.
2. Mark the class the student will be attending.
3. Enter any notes for today. The notes will be printed on the name tag and check in roster. They are not stored in the database.
4. Any allergy information that is already in the database will be displayed. If you need to
Update the necessary contact information.
5. If there are any custody comments in the database for this child, they will be displayed at the bottom of the options screen. If you need to add custody comments or update existing custody comments do that here.
6. Enter any CheckIn Alerts at the bottom of the options screen.

7. Once you’ve entered this information, click DONE to save the updated information. From the check in screen, click CHECKIN to complete the check in process.

**Update Profile Information**

If you would like to update general contact information for this student, tap on the EDIT PROFILE button. To make those changes:
1. From the list of family members, click on the EDIT button to the right of the student’s name.

Click ADD TO FAMILY to add other children to this family.
Enter the new family member’s information. Click FINISHED or ADD ANOTHER.

2. Click on the EDIT PROFILE button at the top of the window.
3. Make any necessary changes.
4. Click SAVE & CLOSE to save these updates.

Click ADD VISITOR

Enter the name and information for the first person in the family. Click ADD ANOTHER.
Pull in a Picture
You can import an individual’s picture through the options window. From the list of family members, click on the EDIT button to the right of the student you wish to import a picture for. Tap on the CHOOSE FILE underneath the picture area. Navigate to the their picture on your device. Click OPEN.

Add a New Person into an Existing Family
If you need to add a person to a family that already exists in your database, do the following:
1. From the main check in screen enter the last name of the family then click GO.
2. From the list of family members, click ADD TO EXISTING FAMILY button.

Check In by Individual Using a Last Name or Phone
The check in by individual is a great option for checking in youth group students, event participants or day care students. It is for those times that you are not checking in multiple members of the same family… but just one person at a time.

Enter Last Name, comma, First couple of letters or you can enter last 4 of phone.
If you check in user is defined to “check in by individual”, you can type in the first few character of the last name, then a comma, then the first few characters of the first name or the last 4 digits of a phone number. Then press the enter key or press the SEARCH button. This can be done with a keyboard/mouse or with the virtual keyboard on a touch screen monitor.

A list of individuals that met the name or phone criteria will be displayed. Highlight the person that is present to check in then press the SELECT button to get to check in screen. If there is only one person that met the criteria the system will take you right to the check in screen.

A list of all the classes the student is enrolled in, that are currently meeting will be displayed. Click on the checkmark to the right of each class you’d like to check them into. Then click on the CHECK IN button in the lower right.

If you would like to check the student into a completely different class, click on the hamburger button in the lower left. This will give you an option to choose “Additional Choices”. When you choose this option a list of all the classes available for check in will be displayed. Click on the checkmark to the right of the class, click CHECKIN to check them in.
Check In by Group or Event

If you would like to view a roster of students enrolled in a class and have the ability to mark them present, you will want to check in by group. This method records check in and check out times, but it does not print name tags and it does not allow for the entry of visitors.

To check in by group or event, you’ll need to log onto your tablet as a mobile check in user that has the preference to “check in by group” or “check in by event”. For more information on creating users, see the chapter on “Configuring Child Check In”.

To update allergy information, profile data, check in alerts or bar codes, simply click on the hamburger menu and choose the appropriate option. A window will be displayed for you to enter or modify that data.

From the hamburger menu, choose allergies. This window will be displayed to enter allergy information.

Select the group or class you’ll be checking folks into.
3. Enter the child’s name at the bottom of the window.
4. Tap ADD ANOTHER to add additional family members.
5. Tap FINISHED to save the information and return to the list of families to check them in.

Click on checkmark to the right of a student's name to check them in.

Check in Visitors
To check visitors into a class or group, click on the ADD VISITOR button. Enter the name of the first person in the family. Click ADD ANOTHER to enter the next person in the family until everyone is entered. Make sure the children you’ll be checking in have a family position of CHILD. Once you’ve entered everyone, tap FINISHED.

Now you’ll be taken to an area where you can enter the address and phone information for this family. Enter that, then tap CONTINUE.

Now you will be at the screen that lists all family members. If you’ve entered a grade or birthdate for each of those children and your classes have a grade/age range preference, you’ll see a recommended class for each child in the Checking Into column. If those are in fact the classes you want to check them into, tap CHECK IN ALL.

Choose the worship service you'll be recording attendance for.
If you’d like to check them into a different class, tap the EDIT button. Choose the class/classes you’d like them to check into, click DONE to return to the check in screen. Once you’ve completed this process for everyone, click CHECKIN to complete the process.

Once you’ve logged onto the check in system on your tablet, you’ll have a drop down list of all groups/classes that are currently meeting. Choose your class. You’ll be presented with a list of students in that class. Tap on the check mark to the right of their name to check them in. Tap on check out (open door) to check them out of the class.

**Check In by Service**

If you would like to view list of people from your database and have the ability to mark them present at a worship service, you will want to check in by service.

To check in by service, you’ll need to log onto your tablet as a mobile check in user that has the preference to “check in by service”. For more information on creating users, see the chapter on “Configuring Child Check In”.

---

Tap the check mark to the right of the family to check in entire family.

Tap on family name to view list of all family members. Click on checkmark to right of family member to check them in.

If you’d like to check them into a different class, tap the EDIT button. Choose the class/classes you’d like them to check into, click DONE to return to the check in screen. Once you’ve completed this process for everyone, click CHECKIN to complete the process.

Once you’ve logged onto the check in system on your tablet, you’ll have a drop down list of all groups/classes that are currently meeting. Choose your class. You’ll be presented with a list of students in that class. Tap on the check mark to the right of their name to check them in. Tap on check out (open door) to check them out of the class.

**Check In by Service**

If you would like to view list of people from your database and have the ability to mark them present at a worship service, you will want to check in by service.

To check in by service, you’ll need to log onto your tablet as a mobile check in user that has the preference to “check in by service”. For more information on creating users, see the chapter on “Configuring Child Check In”.

---

85
All students with that keyword are listed.

Mark check mark to check them into the class listed.

Once you’ve logged onto the check in system on your tablet, you’ll have a drop down list of all services that are currently meeting. Choose your service. You’ll be presented with a list of families that have the associations you selected for that service. Press the check mark to the right of the family to mark each person in the family present. Tap on the family name, to select specific individuals in that family to mark them present.

Note the total count in the upper right of the window. That indicates how many people you have.
marked as present. If you need to add to that number to get to the real head count, add that in the field underneath.

**Check In by Keyword**

The check in by keyword allows you to check in folks that have a specified keyword. This is a great option for managing bus ministries. You could have all the students that are on bus route1 assigned that “bus route1” as a keyword. The bus driver can log in as the mobile check in user for keyword bus route1.

Once he logs in, it will return a list of students that have “bus route 1” as their keyword. Notice the Checking Into column. This will denote the class this child is enrolled in. To check the child in, tap the check mark to the right of the name. Click PRINT LABELS to send the nametags for the checked in kids to the printer.

**Determine Headcounts**

Notice the dashboard tab in the upper left of your window. This tab is not available for “self check in” users. Tap on the dashboard tab to view the counts for each class. The total count is the number of folks who have checked into a specific class. The head count is the number of students who are still checked into the class.

To drill down and view the details of who is in the class, tap the DETAILS button to the right of the group/class name.
Choose the authorized person that is checking the child out.

**Check Out**

**Compare tags**
One method of checking the students out is to compare the security number on the child’s name tag with the security number on the parent tag. If the numbers match the teacher can release the child.

Using this method, you will want to make sure to have policies in place to handle the circumstance where a parent looses the parent tag.

**Using Check In Screen**
You can also check students out through the Roll Call system. When they are logged out, the check out time is recorded and any custody comments are displayed on the screen.
Choose the authorized person that is checking the child out.

To log a student out:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Identify the student that is checking out by searching name or phone.
3. Highlight the specific family.
4. From the list of family members, click the check mark in the out column. Click CHECKOUT.
5. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out.
6. Make your selection and tap CHECKOUT.

Using Dashboard
You can also check students out through the dashboard tab on the check in screen. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out this way:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Tap the dashboard tab.
3. Click on the by person tab.
Find your Numbers and API key from the NexMo dashboard.

4. Scroll through the list of students that are checked in to find the student you wish to check out.
5. Tap on the check out button (looks like an open door).
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out. Make your selection and click CHECKOUT.

Sending Texts from Check In Screen
Using Mobile CheckIn, you must use the SMS service NexMo to send texts through the tablet.

Tap the text button to the right of the student's name that you need to send a text for.
Enter text message.

Choose who to send text to.
OPERATING THE CHECK IN STATIONS (Smart Phone)

Log into the Check In System
To use the check in functionality of Roll Call on a smartphone, you must have a Mobile Check In license or activated the trial for Mobile Check In. You will need to get to the login screen from your phone’s browser by entering the IP Address of your Roll Call Server as the URL. It is recommended that you fix the IP Address of your Roll Call Server machine.

From the login screen, enter the user name that you created as your mobile check in user. Enter the password for that user. Choose “Phone” as your App Format.

Check In Using a Last Name or Phone Number
To check a family in based on their last name or phone number, tap in the entry field. Enter the name or last four digits of the phone number. Tap SEARCH.

Enter mobile check in username, password and select phone as app format.

Enter name or phone, then enter value you are looking for, then tap SEARCH.
A list of families with that last name will be displayed. Tap on the family that is present to check in to get to the list of family members. If there is only one family with that last name the system will take you right to the list of family members.

To check in everyone listed, tap Check In All. If you want to check in only certain children, move the slider underneath their class, to check them in. Once you’ve selected each child that will check in, tap on Check In to complete the check in process.

Note the class that the child will be checked into is listed under their name on the screen. If you would like to change which class the child will go to, tap on the students name to get to the options window. All classes that are currently meeting will be listed underneath the allergy and notes area. Use the slider to choose which class they should check into. Tap DONE. To complete the check in process, tap CHECK IN.

If the child is not enrolled in any classes that are currently meeting, tap on the students name to get to the options window. Choose the class you’d like to check them into. Tap DONE to return to the list of family members. Tap CHECKIN to complete the process.
From the options window, scroll down to the Select Meetings section.

Check in Options

Check into Different Class
The class a child will be checked into is listed underneath their name. If you’d like to check them into a different class, tap on the student’s name to get to the options window. Mark the class(es) you’d like the child to attend. Tap DONE to return to the list of family members. Tap CHECK IN to complete the process.

Check into Multiple Classes
The class a child will be checked into is listed underneath their name. If you’d like to check them into additional classes, swipe to the left on the student’s name to get the options window. Mark the class(es) you’d like the child to attend. Tap DONE.

Mark multiple classes to check them into both.

Enter Allergy, Note, Custody Comment or Check In Alerts
If you need to record any notes, allergy, custody comments or check in alerts for a student, do the following:
1. From the list of family members, tap the student’s name to get to the options window.
2. Enter any notes for today. The notes will be printed on the nametag and check in roster.
They are not stored in the database.

3. Any allergy information that is already in the database will be displayed. If you need to update or add to that information, make those changes on the option screen.

4. If there are any custody comments in the database for this child, they will be displayed at the bottom of the options screen. If you need to add custody comments or update existing custody comments do that here.

5. Enter any Check-In Alerts at the bottom of the options screen.

6. Mark the class the student will be attending.

7. Once you’ve entered this information, tap DONE to save and return to the list of family members.

**Update Profile Information**

If you would like to update general contact information for this student:

1. From the list of family members, tap the student’s name.
2. Tap on EDIT button (looks like pencil).
3. Make any necessary changes to contact information.
4. Click SAVE.
Pull in a Picture
You can pull in an individual’s picture through the options window. To get to the options window, swipe to the left on that student’s name. Tap on the CHANGE PHOTO underneath the picture area. Navigate to the their picture on your device. Click OPEN.

Add a New Person into an Existing Family
If you need to add a person to a family that already exists in your database, do the following:
1. From the main check in screen enter the last name of the family then tap SEARCH.
2. From the list of family members, tap ADD TO EXISTING FAMILY.
3. Enter the new family member’s information in the window that is displayed.
4. Tap SAVE PERSON to save the information.
5. Enter another person or tap CONTINUE to return to the list of family members.
Enter family member’s profile information.

Tap Visitor to begin entering information for a visiting family.

Check in Visitors

To check visitors into a class or group, tap VISITOR in the upper right. Enter the name of the first person in the family. Click SAVE PERSON to save that information and begin to enter the next person in the family until everyone is entered. Go down to the address section to enter that information if you’d like. Once you’ve entered everyone tap CONTINUE.

Now you will be at the screen that lists all family members. If you’ve entered a grade or birthdate for each of those children and your classes have a grade/age range preference, you’ll see a recommended class for each child underneath their name. If those are in fact the classes you want to check them into, tap CHECK IN ALL.

If you’d like to check them into a different class, TAP on the student’s name get to the options window. Choose the class/classes you’d like them to check into, tap DONE to return to the list of family members. Tap CHECK IN to complete the process.
Enter family members name and profile information, tap SAVE PERSON.

When all family members entered, tap Continue.

Note recommended class. Tap check mark to check them into this class.

Check In by Group

If you would like to view a roster of students enrolled in a class and have the ability to mark them present, you will want to check in by group. This method records check in and check out times, but it does not print nametags and it does not allow for the entry of visitors.

To check in by group, you’ll need to log onto your phone as a mobile check in user that has the preference to “check in by group”. For more information on creating users, see the chapter on “Configuring Child Check In”.

Once you’ve logged onto the check in system on your phone, you’ll have a list of all groups/classes that are currently meeting. Tap your class. You’ll be presented with a list of students in that class. Tap on the check mark to the right of their name to check them in. Tap on check out (open door) to check them out of the class.
Check In by Service

If you would like to view list of people from your database and have the ability to mark them present at a worship service, you will want to check in by service.

To check in by service, you’ll need to log onto your phone as a mobile check in user that has the preference to “check in by service”. For more information on creating users, see the chapter on “Configuring Child Check In”.

Once you’ve logged onto the check in system on your phone, you’ll have a list of all services that are currently meeting. Tap the specific service. You’ll be presented with a list of families that have the associations you selected for that service. Mark the box to the right of the family to mark each person in the family present. Tap on the family name to get to a list of specific individuals in that family to mark them present one at a time.
Check In by Keyword

The check in by keyword allows you to check in folks that have a specified keyword. This is a great option for managing bus ministries. You could have all the students that are on bus route 1 assigned that “bus route 1” as a keyword. The bus driver can log in as the mobile check in user for keyword bus route 1.

Once he logs in, it will return a list of students that have “bus route 1” as their keyword. Notice the class they’ll be checked into listed underneath their name. This will denote the class this child is enrolled in. To check the child in, tap the check mark to the right of the name. Tap printer in upper right to send the nametags for the checked in kids to the printer.

Determine Headcounts

From the mobile menu in the upper left, select dashboard then by meeting, person or log. If you choose by meeting, a list of meetings will be displayed with the headcount for each class. If you choose by person, it will list all the folks that are currently checked in and indicate what they are checked into. The log will show all check in’s and check outs.
Dashboard shows all meetings and headcounts.

If you choose dashboard, by person, you will get a list of all individuals that are currently checked in.

Check Out

Compare tags
One method of checking the students out is to compare the security number on the child’s name tag with the security number on the parent tag. If the numbers match the teacher can release the child.

Using this method, you will want to make sure to have policies in place to handle the circumstance where a parent loses the parent tag.

Using Check In Screen
You can also check students out through the Roll Call system. When they are logged out, the check out time is recorded and any custody comments are displayed on the screen.

To log a student out:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Identify the student that is checking out by searching name or phone.
3. Highlight the specific family.
4. From the list of family members, move the slider under the checking out section for each student.
5. Tap CheckOut in the upper right hand, to check them out.
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out.
7. Make your selection and tap CHECKOUT.
Once you’ve selected the family, move the slider to choose this child for checkout.

Using Dashboard

You can also check students out through the dashboard tab on the check in screen. When they are logged out, the out time is recorded and any custody comments are displayed on the screen.

To log a student out this way:
1. Log onto Roll Call as a check in user that has “check out” privileges.
2. Tap the dashboard tab.
3. Click on the by person tab.
4. Scroll through the list of students that are checked in to find the student you wish to check out.
5. Tap on the check out button (looks like an open door).
6. If you have entered “authorized check out” person’s for this specific student, a screen will pop up asking you to pick who is checking the child out. Make your selection and click CHECKOUT.
Sending Texts from Check In Screen

Using Mobile CheckIn, you must use the SMS service NexMo to send texts through the phone.

NexMo Settings

Configure the following settings:

1. Select Preferences from the Edit menu at the top (Windows machines) or the Roll Call menu (Mac machines).
2. Highlight SMS Texting from the left sidebar.
3. Select the option to use NexMo.
4. Enter the API Key provided to your organization by NexMo.
5. Enter the Secret Key provided to your organization by NexMo.
6. Enter the NexMo number that was provided to your organization.
7. Enter any Msg Prefix. This will be in front of every text that is sent.
8. Click OK to save this information.

From the Roll Call Preferences window, choose NexMo as your SMS texting options.

Find your Numbers and API key from the NexMo dashboard.
Sending the Text

Once you have your preferences and settings configured, you are ready to send a text. To send a text from the check in system, do the following:

1. Click on the hamburger menu in the upper left.
2. Choose by Person, underneath Dashboard.
3. Find the student you need to send a text for.
4. Click on the text icon.
5. Choose who you will send the text to.
6. Type in your text message.
7. Click OK to send the texts.
**USING FINGERVEIN SCAN TO CHECKIN**

**Fingervein Technology Configuration**

To identify and check children in using fingervein scan, you will need to install the M2SYS Server and Client software on Windows machines (2003 Server, Windows XP, Vista, or Windows 7). The installation instructions for this software can be found on your installation CD or at www.M2SYS.com.

The fingervein scanner must be plugged into a USB port on the client machines.

**Fingervein Set Up with Roll Call**

The first step is to set up the BioPlugin Adapter settings on each of the client machines. Double click on the BioPlugin Adapter icon. From the finger print window, click on the SETTINGS button.

Click on SETTINGS button to enter administrative information.

Click on General tab.

Enter IP address and Port number of the Biometric Server.

From the General tab, you’ll need to enter the IP address and port number of the Biometric Server. This information can be found in the Control Panel under Biometric Server.
From the Interface tab, you’ll need to indicate this is a Keyboard Interface.

Select Keyboard interface.

From the Destination Windows tab, you’ll need to indicate that you are connecting to Roll Call. If you are using a single check in station, the *Window Title* is “Roll Call”. If you have multiple check in stations and are using a network version of Roll Call, the *Window Title* is also “Roll Call”. Enter rolcall as the *Keystroke Destination*. Make sure the suffix is set to p {enter}

Enter Roll Call or Roll Call Client as the Window Title.

Set suffix to p{enter}.

**Connect a Fingervein with a Person in Roll Call**

When a person arrives to check in, you’ll need to first identify that person in Roll Call. Click on the FIND BY NAME button and click on the specific individual. From the Automated Attendance window, note this person’s ID in the upper right corner.

Next, bring up the Biometric SnapOn Adapter. Click on the Fingervein ADMINISTRATION button to enter this person’s Roll Call ID and scan their fingervein.
Click on Fingervein ADMIN to record Roll Call ID and scan fingerprint.

From the Fingervein Admin window, enter the person’s ID number, then click on the REGISTER A NEW PRINT button.

Enter the ID from the Roll Call checkin screen.

Note the ID number from the options window in the check in system.
The next screen allows you to scan the individuals fingervein. Make sure you set a standard for which finger and on which hand will be scanned. Click on the right side to capture the fingervein. Have the student place their finger on the scanner. They will need to scan their print three times. A message will come up indicating a successful scan.
REPORTING ON ATTENDANCE

Attendance Summary

The attendance summary report gives head count information for service and group attendance information. This report can be run by day and it will list each service and or group, the day they met, how many attended and how many visitors attended. The Attendance Summary can also be run by week, month or year. When running for this time frame, it will display the appropriate headcount.

To run the attendance summary report by day:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select “By Day” as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
To run the attendance summary report by week, month or year:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.
5. Select by week, by month or by year as the report type.
6. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
7. Click GENERATE to run the report.
Weekly head-counts for the selected groups.

Note actions that can be performed.

Attendance by Person

The attendance by Person report outlines the different services or groups a person came to if you run this report “by day”. If you run this report by week, month or year it will show you in a spreadsheet format how many times they attended each week, month or year.

To run the attendance by person report by day:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Select “By Day” as the report type.
6. On the “Who” tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.

7. Next click on the “What” tab to choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.

8. Next click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.

11. Click on PAGE SETUP to set your printer and paper size and orientation.

12. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.

13. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.

14. Click on PRINT to send the report to the printer.

15. Click ZOOM IN to make the font in the report larger on your screen.

16. Click ZOOM OUT to make the report font smaller on your screen.

17. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

To run the by person report by week, month or year:

1. Expand the Attendance menu.

2. Click on Reports.

3. Highlight Attendance by Person.

4. Enter the date range for the attendance data you are interested in.

5. Select by week, by month or by year as the report type.

6. On the “Who” tab, select which people you want to run this for. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to see all your Members...
On the criteria tab, choose date range and report type.

On the who tab, indicate the criteria to include people in the report.

and Regular Attenders, choose Associations, then click on Member and Regular Attender to select those values.

7. Next click on the “What” tab to choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.

8. Next click on the Columns tab to choose the information you wish to include on the report. Click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.

Lists the individuals with the number of times they attended during that week.

Note actions that can be performed.
Attendance by Type

The Attendance by Type report will list all the people who came to a group or service on a specific day. This is a great report to run if you want to see who came to your Sunday School classes last weekend and who was absent. Or you can see who attended last Saturday nights service.

To create the Attendance by Type report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance Summary.
4. Enter the date range for the attendance data you are interested in.

5. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
6. On the columns tab, choose the fields you’d like displayed for each person in the report.
7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.
1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

This report lists everyone who attended the service, or group, then lists who was absent.

Note actions that can be performed.

**Attendance by Session**

The Attendance by Session report will list all the people who came to a specific group session or a specific service time on a specific day.

To create the Attendance by Session report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Attendance by Person.
4. Enter the date range for the attendance data you are interested in.
5. Choose which attendance you want to run this for. You may select All and it will list all worship service attendance as well as all group attendance for the date range you entered. You may select Service, and then choose which services you’d like to see or you may choose groups, then pick the specific groups you’d like included in the report.
6. Click GENERATE to run the report.
On the criteria tab, choose the date range, and attendance type.

On the columns tab, double click on a field to move it to selected column.

For each service, group or meeting, the people who attended are listed below.
On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

**Absent Present Report**

The absent/present report allows you to find folks who have been absent so many weeks or who have attended so many times in a certain time frame.

To run the Absent/Present report:
1. Expand the Attendance menu.
2. Click on Reports.
3. Highlight Absent Present.
4. Enter the date range for the attendance data wish to view.
5. On the “Who” tab, select which people you want to evaluate their attendance. You can choose by association, groups, keywords, shepherd areas or search the database. Once you choose your type, you can pick the specific values. For example, if you wanted to evaluate attendance for all your Members and Regular Attenders, choose Associations, then click on Member and Regular.
6. Next click on the “What” tab to choose which attendance you want to use in determining who was present or absent. You may select All and it will evaluate attendance for all services and groups. Select Services and choose the specific services to only look at attendance for those services. Select Groups to choose specific groups.
7. Click on the “When” tab to enter your absent present criteria. Enter how many weeks you wish to look back. Choose to find people who were absent or find people who were present. Enter how many times.

8. Next click on the Columns tab to choose the information you wish to include on the report. Double click on a column name from the left column and move it to the middle column.

9. Click on the View Records tab, to review the people that will be included in the report.

10. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
On the columns tab, double click on a field name to move to the selected column.

Report listing all the folks who met your absent/present criteria.

Note actions that can be performed.

5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.

**Visitor Report**

The Visitor report will list all your first time, second time, third time visitors, based on the association of visitor and the attendance data you wish to evaluate.

To create the Visitor report, do the following:
1. Expand the Attendance menu.
2. Click on Reports.
4. Enter week of attendance you are interested in looking at.
5. Choose the type of visitor you are looking for from the drop down under the Who tab. Then
6. Click on the “what” tab and indicate which type of attendance you wish to evaluate.

On the what tab, indicate the type of attendance to evaluate.

7. Click GENERATE to run the report.

On the right side of the Report Output Window are actions that can be performed for the report.

1. Click on PAGE SETUP to set your printer and paper size and orientation.
2. Click on PREVIEW to preview the output. Do not send the report to the printer from this preview window, it will only send the first page to the printer.
3. To change fonts, column sizes etc., click CUSTOMIZE. The report will be displayed in 4D View, Roll Call’s spreadsheet program. Make your modifications here.
4. Click on PRINT to send the report to the printer.
5. Click ZOOM IN to make the font in the report larger on your screen.
6. Click ZOOM OUT to make the report font smaller on your screen.
7. To save the report as a tab delimited file or html document, click SAVE. Enter the location and name of the file to be saved.
List of visitors from last weekend.

Note actions that can be performed.